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Introduction 

About This Guide 

This guide describes best practices and recommended procedures for creating a custom MSI package 

that will be used to deploy ESSO-LM to end-users. This guide is intended for installation engineers and 

system administrators familiar with Windows Installer (MSI) packaging and enterprise-wide deployment 

of applications. By following the recommendations in this and other ESSO-LM Best Practices guides, you 

will implement an optimal ESSO-LM configuration. 

Terms and Abbreviations 

The following table describes the terms and abbreviations used throughout this guide: 

Term or Acronym Description 

ESSO-LM Oracle Enterprise Single Sign-On Logon Manager 

Agent ESSO-LM Client-Side Software 

Console ESSO-LM Administrative Console 

3BAccessing ESSO-LM Documentation 

We continually strive to keep ESSO-LM documentation accurate and up to date. For the latest version of 

this and other ESSO-LM documents, visit http://download.oracle.com/docs/cd/E15624_01/index.htm. 

 

  

http://download.oracle.com/docs/cd/E15624_01/index.htm
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Packaging ESSO-LM for Mass Deployment 

Overview 

The most convenient way to mass-deploy ESSO-LM SSO is to create a customized MSI package and 

distribute it to end-user machines using a deployment tool of your choice. An end-user machine that has 

been configured and tested for production acts as a configuration “master” from which the target Agent 

configuration will be derived for inclusion in the package. Below is a high-level overview of the required 

steps. The steps are described in detail later in this guide. 

1. Obtain the following: 

a. The latest ESSO-LM installers. 

b. The latest versions of the following documents: 

• Best Practices: Packaging ESSO-LM for Mass Deployment (this document) 

• Best Practices: Deploying ESSO-LM with [your target repository] 

• Best Practices: Configuring the ESSO-LM Agent 

• The Installation and Setup guide for your version of ESSO-LM 

2. If performing an unattended (“silent”) installation, complete the steps in Pre-Requisites for 

Unattended (“Silent”) Installations . 

3. Install the ESSO-LM Agent and the ESSO-LM Administrative Console on the “master” machine. 

4. Place the base Agent MSI package in a working directory on the “master” machine. 

5. Open the base Agent package in MS ORCA or another MSI package management tool and select  

the ESSO-LM components that you want installed on the end-user machines.  

(For example, if your environment calls for a single primary logon method, you may want to 

exclude all but the desired authenticator.) 

Warning: When saving the customized package in ORCA, use the Save function.  

If you use the Save As function, the package will be corrupted. 

6. Configure ESSO-LM using the Console. Make sure you have read the ESSO-LM Best Practices 

guides listed above before you begin. 

7. Generate the final MSI package using the Console. This package will contain the components 

selected in step 5 and configuration settings from step 6. 

8. Test the package by deploying it on a pilot group of machines. Identify and correct any issues 

that may arise. Document the solutions as necessary. 

9. Once the pilot deployment is successful, deploy the MSI package enterprise-wide using  

a third-party tool of your choice. 
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Pre-Requisites for Unattended (“Silent”) Installations 

In order to successfully install ESSO-LM in unattended ("silent") mode, the Windows Management 

Instrumentation (WMI) service must be running before the installer is executed. 

To check whether the WMI service is running, and start it if necessary, do the following on each target 

machine: 

1. Open the System Management Console. 

2. Open the Services snap-in. 

3. Navigate to the Windows Management Instrumentation service and check its status and 

startup mode. 

4. Depending on the status, do one of the following: 

 If the status is Started, the WMI service is running; proceed to the next section. 

 If the status is blank, check the service's startup type and start it as follows: 

o If the startup type is Disabled, do the following: 

1. Double-click the service. 

2. In the dialog box that appears, change the startup type to Manual or Automatic,  

as required by your environment. 

3. Click Apply. 

4. Click Start to start the service. The status changes to Started. 

o If the startup type is not Disabled, do the following: 

1. Double-click the service. 

2. In the dialog box that appears, Click Start to start the service.  

The status changes to Started. 

3. Click OK. 

5. Click OK to close the service properties dialog box. 
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Step 1: Prepare the “Master” Machine 

1. Create a working directory and copy setup.msi to that directory.  

(Make sure to remove the “read-only” attribute from setup.msi, if present.) 

2. Rename setup.msi to  
<company name>_esso-lm_<version>_agent_base_setup.msi 

Step 2: Select ESSO-LM Components for Inclusion in the Package 

Note: This procedure uses Microsoft ORCA as an example. You can use another tool if desired. 

1. Install MS ORCA. The tool is part of the Microsoft Windows SDK, which is available at: 

http://go.microsoft.com/fwlink?LinkID=55774 

2. Open the MSI package in ORCA and customize its contents as follows:  

a. In the Tables pane, select Feature. The right-hand pane displays the package contents.  

The shipping defaults (valid as of this document’s release) are shown in Figure 1. 

 

Figure 1 ORCA window showing the default configuration for the ESSO-LM package  

http://go.microsoft.com/fwlink?LinkID=55774
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b. Include or exclude the desired components as follows: 

• To include a component in the package and install it during deployment, set its  

Level value to 1.  

• To include a component in the package without installing it during deployment, set its 

Level value to 101. The component will be available for installation after deployment via 

the Add/Remove Programs applet in the Windows Control Panel. 

• To exclude a component from the package, set its Level value to 0. The component will 

not be available for installation after deployment via the Add/Remove Programs applet. 

Note: Package components are grouped by category, such as Synchronization 

Manager or Event Manager. To include a component that is a child of a given 

category, you must include that category in the package. For example, to 

include the Active Directory Synchronizer, you must also include its parent, 

the Synchronization Manager node.  

Component names displayed in the Title column are consistent with the names displayed in 

the ESSO-LM installer. The default installer tree is shown in Figure 2 on page 9. 
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Figure 2 Default ESSO-LM installer tree  
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Follow these guidelines when customizing the contents of the package: 

• Do not change any values in the Feature table other than the Level values. 

• Do not change the Level value for the Java Support component. This component is 

installed automatically whenever a JRE or JDK is detected on the target system.  

To exclude Java support from the package, modify the Level value for the JavaHelper 

entries in the Condition table instead of the Feature table. 

• Do not include unneeded components, especially authenticators. For example, if your 

primary logon method will be Windows Logon v2, exclude the remaining authenticators 

from the package, unless your environment specifically calls to use them. 

c. Save the package using the Save command in the File menu. 

Warning: If you save the package using the Save As command, the package will be 

corrupted. 

For more information on using Microsoft ORCA, see http://support.microsoft.com/kb/255905. 

Step 3: Prepare the Target Configuration Set 

Prepare the target Agent configuration set as follows: 

1. Start the ESSO-LM Administrative Console. 

2. In the tree in the left-hand pane, right-click Global Agent Settings and select 

Import  From Live HKLM from the context menu that appears. 

3. Rename the Live configuration set to properly identify it as package settings: 

a.  Under Global Agent Settings, right-click the Live node and select Rename from the 

context menu. 

b. Enter Package Settings and hit Enter. 

3. Blank the values of and exclude (disable) all settings that specify an absolute path to a file: 

Caution: If you do not complete this step, deployment will fail on environments (such as 

Citrix) where the target installation path differs from the path hardcoded in the 

package. The installer automatically substitutes the correct paths during 

deployment. 

a. For each event logging method under Event Logging, delete the value and deselect the 

check box for the Extension location setting. Do the same for the Event Server Message 

Library location setting under Event Logging  Advanced. 

b. For each included synchronizer under Synchronization, delete the value and deselect 

the check box for the Extension location. 

Caution: Do not write these customized package settings to the local registry (i.e., use 

the Write to Live HKLM function). Doing so will break the configuration set and 

result in a non-functioning deployment.   

http://support.microsoft.com/kb/255905
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4. Save the package settings to an XML file for future reference:  

a. From the File menu, select Save.  

b. When prompted, enter Package Settings as the file name and click Save. 

Step 4: Generate the Final MSI Package 

1. In the Console, select Generate Custom MSI from the Tools menu. The console displays the 

“Generate Customized MSI” dialog: 

 

 
 

2. In the dialog, do the following: 

a. In the Base (.MSI) field, click the Browse (…) button, navigate to the MSI package you 

modified using ORCA, and click Open. 

b. In the Output (.MSI) field, click the Browse (…) button and name the output MSI file.  

Use the same name as in step 2a but omit the word “base”. Click Save. 

Caution: Do not include any application templates in the MSI package. Templates 

become outdated very quickly and for this reason should only be delivered to 

end-users via synchronization with the central repository. 
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c. In the Global Agent Settings field, click Choose. The Console displays the “Configure 

Applications” dialog: 

 

 
 

d. In the dialog, make sure Use Administrative Console as Source is selected. 

e. Select Package Settings from the drop-down list and click OK.  

f. Click OK in the parent dialog and wait for the Console to generate the package.  

g. When the package has been successfully generated, the Console displays a confirmation 

message. Click OK to dismiss the message. 

Step 5: Test the Package (Pilot Deployment) 

Once you have generated your custom MSI package, test it by installing it on one or more pilot 

machines. Always install the package on a clean machine – that is, one that does not contain any ESSO-

related files or registry entries. If you are using the same machine to test multiple packages, you must 

clean it up before installing a new package so that old settings and files do not remain. If the installer 

detects existing data, it will perform an upgrade instead of a normal installation, resulting in false 

problems and false positives during testing. 

1. Delete the following directories: 

 \Program Files\Passlogix and all of its contents 

 On Windows Vista: \Users\<user>\AppData\Roaming\Passlogix 

 On Windows 2000 and Windows XP:  

\Documents and Settings\<user>\Application Data\Passlogix and all its 

contents 

2. Delete the following registry keys: 

 HKEY_LOCAL_MACHINE\Software\Passlogix including all sub-keys 

 HKEY_CURRENT_USER\Software\Passlogix including all sub-keys 
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When testing the package, look for any deployment and configuration problems; Oracle highly 

recommends that you set up a dedicated test environment so that you can perform a full range of 

staging tests, including the chosen global Agent settings, administrative overrides, synchronization with 

your central repository, and response to applications. The last item will require that you create a set of 

pilot templates and test them against a selected set of applications. This will let you spot and correct any 

application response issues that would have otherwise arisen (and been much more costly to resolve) in 

production.  

Step 6: Deploy the Tested Package to End Users 

When the package has been fully tested and verified, use a deployment tool (such as Microsoft Systems 

Management Server) to deploy ESSO-LM enterprise-wide. 
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